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1. Register as an external user

Please note that:

1.2.
1.3.

1.4.

UN Secretariat staff members, including field staff members, should not register: to find out your
internal user account access codes, kindly refer to chapter 1.2.1 of the Instructional Manual for the
Applicant.

UN Volunteers, associate experts, consultants, individual contractors, military/police personnel and
interns are invited to register as external users using the steps below.

If you have already registered but do not remember your inspira User ID or your password, click on
the “Forgot User ID" or “Forgot Password” link located on the inspira login page and follow the
instructions on the screen. Make sure you check the spam/junk folder of your email account.

For Galaxy users, kindly note that you cannot use your Galaxy access codes to log into inspira and
that it is not possible to transfer your information from Galaxy to inspira.

. On the UN Careers website homepage (hittps://careers.un.org) click on “Login” or go directly to

https://inspira.un.org

Click on “Register now".

Fill out the registration form make sure your date of birth is correct and follows the format
dd/mm/yyyy.

Click on "Register”.

2. Update your profile

To update your profile, please follow the steps below:

2.1.
2.2.
2.3.

2.4.

Log intfo inspira (hifps://inspira.un.org).

On the inspira "Home" page, click on the “My Profile” icon.
Fill out the three sections namely,

= Personal Details

=  Family Details

= Nafionality & Residence

Click on “Save” 2> A warning message will appear if all required items have not been filled in.
A warning “The applicant is already registered in the system” will also appear if the primary email
address indicated in your profile is already assigned to another inspira account registered under
the same name and same date of birth. When all required fields of your profile have been
completed, the status of your profile becomes “100% Complete”.

3. Create your first application

To create your first online application, please follow the steps below:

3.1.
3.2.
3.3.
3.4.

Log into inspira (hifps://inspira.un.org).

On the inspira "Home" page, click on the “My Applications” icon.
Click on the “Create Draft Application” button.

Read the information on your screen, tick the “Confirm” check box and then click on the “Nexi”
button.
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3.5. Select one of the following 3 options to start your new online application:

OPTION #1: " " > Use this option to create a new online application
based on the content of an existing online application. By default the “Source Application
Information” table will display the last application created but you can pick a different one by

clicking on the lookup icon L This option is disabled if you do not have any online application

saved vyet.

OPTION #2: " = Use this option to create a new online application from
scrafch.

OPTION #3: " " = Use this option 1o create a new online application based on the

content of a fully completed Offline Application Template (the Offline Application Template can
be downloaded from the inspira "Home"” page by clicking on the link “Download Offline
Application Template”).

3.6. Clickonthe* " button.
The online application is divided info 5 main sections (+ 1 Review/Submit page):
= Screening questions (populated only when you apply to a specific job opening)
» Preferences
= Education & Work Experience
= Skills

= Cover Leftter (itself subdivided into “Cover Letter”, “Personal Information” and “References”)

3.7. Click on the * " pbutton to move from one section/subsection fo the next. Complete each
section and subsection to the best of your ability.

Recommendation: Click on regularly. The inspira system times out every 20 minutes so
clicking on “ " regularly reduces the risk of losing unsaved data. When doing so, the text
. " should appear in a popup
window. If a warning message appears in relation to an invalid value in a field followed by a

lookup icon Da, clear this field and then click on the lookup icon to pick one of the predefined
enfries. Such a field may also be left blank if not marked as required.

3.8. Click on the “Exit" button to return to the * " page: your new draft application is
now listed in the "My Applications” table. From this table, you have access to:

= The “Creation Date” which indicates the date the application was created;

= The “Application Date” which indicates the date you submitted your application;

= The "View/Print PHP*" printer icon =] to access the PDF version of your application;

The PHP or Personal History Profile is the PDF file resulting from the combination of your
“profile” and one of your “applications”.

» The status of each application (e.g. Draft, Applied, Under Consideration, etc.)
- Only Draft applications can be updated.

Note: At this stage you have not applied to any job opening yet. However, by preparing your online
application early and regularly updating it, you will be able to apply in just minutes the day you find a
suitable job opening.
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4. Search and apply for a job

To search and apply for a job in inspira, please follow the steps below:

4.1.
4.2.
4.3.
4.4.

4.5.

4.6.

4.7.

4.8.

4.9.

Log into inspira (hifps://inspira.un.org).

On the inspira *"Home" page, click on the “Job Search” icon.
Enter your search criteria and then click on the “Search” button.

Click on the relevant search result, read its full description and click on *Apply Now" if you wish to
apply.

Read the information on your screen, tick the “Confirm” check box and then click on the “Next”
button.

Select one of the following 3 options to start your new online application ...

OPTION #1: “Choose Existing Application” - Use this option to create a new online application
based on the content of an existing online application. By default the “Source Application
Information” table will display the last application created but you can pick a different one by
clicking on the lookup icon “, This option is disabled if you do not have any online application
saved vet.

OPTION #2: “Build New Application” - Use this option to create a new online applicatfion from
scrafch.

OPTION #3: "Load From File” > Use this option to create a new online application based on the
content of a fully completed Offline Application Template (the Offline Application Template can
be downloaded from the inspira "Home"” page by clicking on the link “Download Offline
Application Template™).

... and then click on “Nex{".

Answer the “Screening Questions”, then click on “Save”, "OK" (in the popup window) and
“Next".

Complete/update each section and subsection of the application. Click on the “Next” button or
the “Previous” button fo move between sections/subsections.

Recommendation: Click on “Save” regularly. The inspira system times out every 20 minutes so
clicking on "Save"” regularly reduces the risk of losing unsaved data. When doing so, the text
“Your in-progress application has been saved but not submitted” should appear in a popup
window. If a warning message appears in relation to an invalid value in a field followed by a

lookup icon QJ, clear this field and then click on the lookup icon to pick one of the predefined
entries. Such a field may also be left blank if not marked as required.

When you are ready to submit your application, click on the "Next” button until you reach the
“Review/Submit” step: This step gives you an opportunity to review all the sections of your
application. This step is even more important that once an application has been submitted, it
cannot be updated.

If a subsection needs to be updated, click on the pen iconﬁ? associated to it, update the
information, click on “Save”, “OK"” and then click on the “Review/Submit” link in the upper
section of your screen.

When your application does not need any additional update, click on the “Submit Application”
button.

Read carefully the Terms and Agreements, then select "l agree fo these terms” and finally click
on the button “Cerlify and Submit Application”. Immediately after submitting your application,
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the message “Your job application has been successfully submitted.” should appear on your
screen.

Finally, click on the “Return to Job Search” link and then on the “My Applications” link (in the
upper part of the screen): In the “My Applications” table, the status of the application that you
have just submitted should be “Applied”.

é Important note:

= You can submit only one application per job opening (and you cannot update it after
submission).

= Withdrawing your application will not allow you to submit a new application for the same job
opening; therefore do not withdraw an application unless you are no longer interested in this
job opening.

= [tisrecommended fo always apply well in advance before the application deadline date.

- For more details and guidance on how to apply for a job in inspira, kindly refer to the Instructional
Manual for the Applicant accessible by clicking on the “Manuals” link inside inspira.

. Activate Job alerts [optional]
5.1. Loginto inspira (hifps://inspira.un.org).

5.2. On the inspira *"Home" page, click on the "Job Search” icon.
5.3. Enter your search criteria.

Note: The first fime you perform this job search, you may consider running it with the field “Find
Jobs Posted Within" sef to “Anytime"” so that you can find all current job openings matching your
other search criteria.

5.4. Click on the “Save Search Criteria” button.

5.5. Name your search.

5.6. Tick the checkbox [x] Use as Job Alert

5.7. Type an email address in the “Send Job Alerts nofification to” field.
5.8. Click on the “Save Search” button.

Please note that:

= Saved searches and job alerts stay valid for 6 months only;
=  Maximum number of active saved searches is 5.

. FAQ

6.1. | cannot submit my application, why?

The “Submit Application” button is available only at the “Review/Submit” step of the online
application process (step 8 of 8). It is active only if your application is linked to a job opening.

If the “"Submit Application” butfton is disabled/greyed out and the top of the page says “Applying for:
You have not selected a job”, click on "Exit” and then "Job Search” to find a suitable job opening.
Once you have found such a job opening, click on the "Apply Now” bufton in the considered job
posting.

Note that to be able to submit an application, all the required fields must be filled and the considered
job opening should neither be closed, nor cancelled nor filled with roster candidates.
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6.2. The list of screening questions is empty, why?

Screening questions appear only when you apply to a job opening. They do not appear if you create
an application that is not linked to any job opening by using the “Create Draft Application” button (as
explained in section 3 of this document). These questions are specific to the job opening and must be
answered before submitting your application.

6.3. What is "Recruit from Roster” job opening? How can | become a roster applicant?

"Recruit from Roster" job openings are only open to roster applicants who are already placed on pre-
approved rosters, following a review by a United Nations Central Review Body. Only roster applicants
who were placed on rosters with similar functions at the same level are considered to be eligible
candidates.

For more information about rosters and roster management, please refer to:

e The UN Careers website (under “ "> "7, Selection notification”);
e Chapter 14in the ;
e The HR Portal ( ).

6.4. | have just submitted my application but | have not received any email confirmation:
how do | know if my application has been received?
To check if your application has been received, simply check its status.

To do so, log into inspira and click on the * "icon:

All your applications along with the ID numbers of the job openings you applied to are listed under the

“My Applications” table. If the status of your application is * "or" ", then
your application has been received. If you cannot find your application, select * "in
the “ " dropdown menu and click on *

You may also want to check that the email address recorded in your profile is correct and that the
spam/junk filter of your email account is configured to allow emails sent from the un.org domain.

6.5. Nothing happens when | click on the “View/Print PHP” printer icon =] , what should | do?
To use this feature, make sure you can tick all the items in the below check list:

[ ] You access inspira using a
(Firefox or Internet Explorer for PC users, Firefox or Safari for MAC users)
[] A PDFreader is installed
[ ] Internet browser configured with pop-up blocker turned off when browsing the un.org domain
[ ] For users of Internet Explorer, go to “Tools” > “Internet Options”.
In the “Security” tab, click on “Custom Level”. Scroll down and select <Enable> for the option
“Downloads” > “Automatic prompfting for file downloads”. Click on "OK"” to confirm.
6.6. The system logs me out immediately after | authenticate, what should | do?

You need to configure your browser so that the un.org domain is always allowed to use cookies.

For Internet Explorer users,

=  Goto “Tools” > “Internet Options”

In the “Privacy” tab, click on “Sites”

* Inthe "Address of website” field, enter un.org and then click on “Allow”
= Click on "OK" to confirm

Note: The session times out automatically every 20 minutes so make sure you click on “Save” regularly.
It is also recommended that you prepare offline your cover letter, list of duties and list of achievements
for each employment record so that you can copy-and-paste this information into your inspira
application.

5/6


https://careers.un.org/lbw/home.aspx?viewtype=AP
https://careers.un.org/lbw/attachments/ManualfortheApplicant.pdf
https://hr.un.org/
https://inspira.un.org/FILES/Browsers.pdf

6.7. 1 am unable to upload my files in inspira, what should | do?
To be able to upload files, make sure you can tick all the items in the below check list:

[] File size is less than 1 Mb (if your file is larger, please scan it in a lower resolution)
[] File name is short and without any special characters (for instance, Initials_Bachelor-degree.pdf)

6.8. Can | withdraw an application in inspira?

Yes, you can withdraw an application from the “My Applications” table of your inspira account. Note
however that withdrawing an application does not allow you to submit a new application for the
same job opening.

6.9. Can |l update an application already submitted?

No, as indicated in the Terms and Agreements, no changes can be made after the application has
been submitted.

6.10.1 cannot find my university when adding my education details, what should | do?

For post-secondary education, a database of degrees from 16,000 university-level institutions
compiled by UNESCO and the International Association of Universities (IAU) is used to streamline the
validation of degrees through inspira.

If you cannot find your university or school when adding your education details to your application,
we recommend that you perform the following steps:

a) Click on the look-up icon @ at the end of the * " field.

b) Click on the * " link.

c) Select " "in the "Long Description” dropdown menu and then enter part of the name of
your institution (for example Chicago if you are looking for University of Chicago).

d) If no result is found, search for * ". Note: If you select "Other Institution”, a new text
field "Please enter name of institution” field is automatically added allowing you to be more
specific.

Note: The fact that your degree may not be part of the UNESCO's and IAU’s database will not
prejudice your application. Under such circumstances, HR practitioners will conduct further checks
during the background verification stage.

For technical support in relation to inspira or the UN Careers website, contact the United Nations Unite
Service Desk by clicking on the “ " link that you can find in and on the

To help us identify your concern, make sure your online enquiry always includes:
a) Your full name and User ID (do not disclose your password);
b) The ID number of the job opening you are frying to apply to (please do not attach your CV);

c) Inthe event that you are reporting a technical problem, the steps leading to this problem +
one or more of the error/warning message and of the page on which it appeared.

Note: The United Nations Unite Service Desk provides technical support only. It does not process
applications and therefore can neither consider CV/resumes nor provide updates on application
status. Thank you for your understanding.
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